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PREFACE

PREFACE
Thank you for purchasing the Garmin®
zūmo™.

Manual Conventions

When you are instructed to “touch”
something, use your ﬁnger to touch an
item on the screen. You will see arrows
(>) used in the text. They indicate that
you should touch a series of items. For
example, if you see “touch Where to >
Favorites,” you should touch the Where
to button, and then touch Favorites.

Contact Garmin

Contact Garmin if you have any
questions while using your zūmo. In
the USA, contact Garmin Product
Support by phone: 913/397.8200 or
800/800.1020, Monday–Friday, 8
AM–5 PM Central Time; or go to www.
garmin.com/support, and click Product
Support.
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In Europe, contact Garmin (Europe) Ltd.
at +44 (0) 870.8501241 (outside the UK)
or 0808 2380000 (UK only).

myGarmin™

Go to http://my.garmin.com to access the
latest services for your Garmin products.
From the myGarmin Web site, you can:
• Register your Garmin unit.
• Subscribe to online services for safety
camera information (see page 52).
• Unlock optional maps.
Return to myGarmin often for new
Garmin product services.

About Google Earth™

Go to http://earth.google.com to
download the Google Earth application.
With Google Earth installed on your
computer, you can view waypoints,
tracks, and routes saved in MapSource®.
From the View menu, select View in
Google Earth.
i
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PREFACE

Important Information
See the Important Safety and Product Information guide for product warnings and legal information.

Notice To Drivers In California And Minnesota:

State law prohibits drivers in California and Minnesota from using suction mounts on their
windshields while operating motor vehicles. Other Garmin dashboard or friction mounting options
should be used. For available accessories, refer to the Garmin Web site at www.garmin.com. Also,
refer to the owner’s manual for instructions on using the included mounting disk with the suction
cup mount. Garmin does not take any responsibility for any ﬁnes, penalties, or damages that may
be incurred as a result of disregarding this notice. (See California Vehicle Code Section 26708(a);
Minnesota Statutes 2005, Section 169.71)

Declaration of Conformity

Hereby, Garmin declares that this product is in compliance with the essential requirements and other
relevant provisions of Directive 1999/5/EC.
To view the full Declaration of Conformity, see the Garmin Web site for your Garmin product:
www.garmin.com/products/zumo. Click Manuals, and then select the Declaration of Conformity.
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GETTING STARTED
Looking at Your zūmo

B
Power button
C
Zoom in, raise volume, or
D
increase brightness.
A
C.
Zoom out, lower volume, or E
decrease brightness.
D.
Page button—scroll through
the Map, Trip Information,
Media Player, and Phone Menu
SD card
Mini-USB port for AC adapter,
pages. Press and hold to adjust
slot
USB Mass Storage mode, and
brightness.
updating software
E.
Speak button—press
to adjust volume
level. Press and hold
Battery pack
to announce voice
(see page 54)
directions.

A.
B.

MCX connector
under weather
cap (see page
55)
zūmo 500/550 Owner’s Manual
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zūmo Tips and Shortcuts

• Touch and hold
to quickly
return to the Menu page.
• Press
to return to the Map page.
• Touch
and
to see more
choices.
• Touch
to adjust settings such
as volume, brightness, language, and
keyboard.

Adjusting the Volume

Press
, and then use
and
to
adjust the volume. For advanced volume
settings, touch
> Volume.

Adjusting the Brightness

Press and hold
, and then use
and
to adjust the brightness. See
page 44 for additional display settings.

Quick Links

• Finding an address: page 11
• Viewing the Map page: page 20
• Using hands-free mobile phone
features: page 23
• Using the Garmin Lock™ antitheft feature: page 10
• Listening to MP3 ﬁles: page 37
• Transferring ﬁles to your zūmo:
pages 34–36
• zūmo audio options, see page 46
• Cleaning and storing your zūmo:
page 55
• Mounting the zūmo in your
automobile: page 47

Fill out the Product Documentation
Survey. Go to www.garmin.com/
contactUs, and click Product
Documentation Survey.
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Mounting the zūmo on Your Motorcycle
WARNING: The terms of the Garmin Warranty require that the power cable
with bare wire leads be installed by experienced installers having the proper
knowledge of automotive electrical systems and skill in the use of special tools
or hardware required for installation.

1: Connect Power to the Mount

Select a suitable and secure location to mount the zūmo on your motorcycle based on
available power sources and safe cable routing.

Power connector

Bare wires
with inline
fuse for power
connection

About Connecting Audio
Standard jacks for microphone (2.5 mm) and audio out (3.5 mm) are located on the
left side of the mount (under a weather cap). When connecting your audio system to
the zūmo, be sure to consider the pathways needed to route the necessary cables. For
information about hands-free audio and phone options, see page 23. For additional
audio conﬁgurations, see page 46.

2: Install the Handlebar Base

The zūmo includes parts for two handlebar installation solutions. Custom mounts can
require additional hardware (www.ram-mount.com).
zūmo 500/550 Owner’s Manual
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A) To install the U-bolt and handlebar
base:

Handlebar
base
U-bolt

1. Place the U-bolt around the handlebar,
and thread the ends through the handlebar
base.
2. Tighten the nuts to secure the base. Do
not overtighten.

Handlebar

B) To install the handlebar base to the clutch/brake clamp bracket:
NOTE: Both 1/4” standard and M6 bolts are included. Match the size of the
factory bolts on your clutch/brake clamp bracket.
1. Remove the two factory bolts
on your clutch/brake clamp
bracket.
2. Thread the new bolts through
the handlebar base, spacers,
and clamp bracket.
3. Tighten the bolts to secure the
base.

Handlebar
base

Clutch/brake
clamp bracket

Spacers
4
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3: Attach the Base Plate
to the zūmo Mount

1. Thread the M4 x 40 mm
ﬂathead bolts and nuts to
attach the base plate to the
zūmo mount.
2. Tighten the nuts to secure the
base plate.

zūmo mount
Base plate

Weather cap

Base plate

zūmo mount

Doublesocket arm

Power
socket
Mini-USB
port
Weather cap
Handlebar base
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Knob

4: Attach the
Base Plate to the
Handlebar Base

1. Align the ball of the
handlebar base and the
ball of the base plate
with the double-socket
arm.
2. Tighten the knob slightly.
3. Adjust for better viewing
and operation.
4. Tighten the knob to
secure the mount.
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5: Install the zūmo
in the Mount

1. Plug the power cable
into the zūmo mount.
For a better seal,
tighten the screws on
the power connector.
2. Flip the lever up.
3. Flip the weather cap
down and under
(magnetic).
4. Place the zūmo into
the mount, and ﬂip the
lever down.
5. Tighten the security
screw.

About the Security Screwdriver
Use the security screw to better secure
the zūmo to the mount. You can connect
the screwdriver to your key chain for
easy access.

6

zūmo mount

Lever

Security screw

Power
cable

Security screwdriver
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Conﬁguring Your zūmo

To turn on your zūmo, press and hold
conﬁgure your zūmo.

. Follow the on-screen instructions to

Acquiring Satellites

Go outdoors to an open area, out of garages, and away from tall buildings. Turn on the
zūmo. Acquiring satellite signals may take a few minutes.
The
bars indicate GPS satellite strength. When the bars are green, your zūmo
has acquired satellite signals, and you can start navigating.

Using Your zūmo

A Displays satellite strength.
B Displays phone and headset connection
C
D
E
F

status.
Displays battery status.
Touch to ﬁnd a destination.
Touch to view the map.
Touch to open the Phone menu (when
connected to a mobile phone with
Bluetooth® wireless technology).

G Touch to view trafﬁc incidents (requires

antenna or receiver and subscription).
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A

B

C

D
F

E
G

H

I

H Touch to open the Media

Player. You can listen to MP3
ﬁles and XM radio (requires
antenna and subscription).
I Touch to adjust the zūmo’s
settings.
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Finding Your Destination

The Where to menu provides several different categories for you to use when you
search for locations.

➊ Touch

Where to.

➍ Select a destination.

➋ Select a category.

➌ Select a sub-

➎ Touch Go.

➏ Enjoy the route!

TIP: Touch
8

and

category.

to see more choices.
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Following Your Route

As you travel, your zūmo guides you to your destination with voice prompts, arrows
on the map, and directions at the top of the Map page. If you depart from the original
route, your zūmo recalculates the route and provides new directions.

Your route is marked with a
purple line.

Follow the arrows as you
take turns.

A checkered ﬂag marks your
destination.

Adding a Stop to Your Route

You can add a stop to your route. The zūmo gives you directions to the stop and then to
your ﬁnal destination.
1. With a route active, touch Menu on the Map page, and
touch Where to.
2. Search for the extra stop.
3. Touch Go.
4. Touch Add as Via Point to add this stop before your
destination. Touch Set as new Destination to make this
your new ﬁnal destination.

zūmo 500/550 Owner’s Manual
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Adding a Detour

If a road on your route is closed, you can
take a detour.
1. With a route active, touch Menu.
2. Touch Detour.

Stopping the Route

1. With a route active, touch Menu.
2. Touch Stop.

Taking a Better Route

As you approach your destination, the
zūmo evaluates road options, to ﬁnd a
better route. If the zūmo ﬁnds a better
route, or
appears in the right
corner of the map. Touch or
to
take the better route.

Locking Your zūmo

1. Touch
>
System >
Garmin Lock.
2. Touch OK, and enter a four-digit PIN.
3. Re-enter your four-digit PIN.
4. Touch OK.
5. Drive to a security location, and touch
Set.

Each time you turn on the zūmo, enter
the four-digit PIN or drive to the security
location.

What is a Security Location?

You can select any location, such as
your home or ofﬁce, for your security
location. If you are at your security
location, you do not need to enter a PIN.
If you forget your PIN, drive to your
security location to unlock the zūmo.
NOTE: To unlock your zūmo at
your security location, the zūmo
must have acquired satellite
signals.

10
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WHERE TO
The Where to menu provides several
different categories you can use to search
for locations. To learn how to perform a
simple search, see page 8.

Finding an Address

1. Touch Where to >
Address.
2. Select a country, state/province, and
city/postal code, if necessary.
3. Enter the address number, and touch
Done.
4. Enter the street name until a list of
streets appears, or touch Done.
5. Select the street and city, if
necessary.
6. Select the address, if necessary. The
Go page opens.
7. Touch Go to create a route to this
address.
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TIP: Do not enter the street preﬁx
or sufﬁx. For example, to ﬁnd North
Main Street enter Main, and to ﬁnd
Highway 7 enter 7.

About Postal Codes

You can search for a postal code. Enter
the postal code instead of the city name.
Not all map data provides postal code
searching.

Intersections

Finding an intersection is very similar
to ﬁnding an address. Touch
Intersection, and enter the two street
names.

Go Page Options

Touch an item in the search results list to
view the Go page.
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Touch Go to create a turn-by-turn route
to this location.
Touch Show Map to view this location
on the map. If the GPS is off, touch
Set Loc. to set this as your current
location.
Touch Save to save this location as one
of your Favorites. See page 14.
If a mobile phone with Bluetooth
wireless technology is connected, touch
to call this location.

Go Home

You can set a home location for the place
you return to most often.
1. Touch Where to >
2. Select an option.

Changing Your Home
Location

1. Touch
>
User Data > Set
Home Location.
2. Select Yes, enter my Address or
Yes, use my current location.

Finding Points of Interest

1. Touch Where to >
Food,
Hotels.
2. Select a category and a sub-category,
if necessary. (Touch the arrows to see
more categories.)
3. Select a destination.
4. Touch Go.

Go Home.

Going Home

After you set your home location, you
can route to it at any time by touching
Where to >
Go Home.

12
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Finding a Location by
Spelling the Name

If you know the name of the location you
are looking for, you can spell it using the
on-screen keyboard. You can also enter
letters contained in the name to narrow
the search.
1. Touch Where to >
Food,
Hotels.
2. Touch Spell Name.
3. Using the on-screen keyboard, enter
letters in the name. Touch Done.
4. Touch the location you are looking
for, and touch Go.

zūmo 500/550 Owner’s Manual

Using the On-Screen
Keyboard

When an on-screen keyboard appears,
touch and slide the yellow box to scroll
through the characters. Touch a character
to enter it.

Touch
to delete the last character
entered; touch and hold
to delete the
entire entry.
Touch
to change the keyboard
mode to use diacritical characters or
special characters.
Touch
to enter numbers.
To change the keyboard display, see
page 44.
13

WHERE TO

Recently Found Locations

Your zūmo stores the last 50 of your
recent ﬁnds in the Recently Found list.
The most recently viewed locations
appear at the top of the list. Touch
Where to >
Recently Found to
view your recently found items.
Touch Save > OK to add a recently
found location to your
Favorites.
Touch Clear > Yes to delete all locations
from the Recently Found list.
NOTE: When you delete recently
found locations, all items are
removed from the list. It does not
delete the actual location from
your unit.
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Favorites

You can save up to 500 locations in your
Favorites, so you can quickly ﬁnd them
and create routes to them. Your home
location is also stored in Favorites.

Saving Locations You Find

1. After you have found a location you
want to save, touch Save.
2. Touch OK. The location is saved in
Favorites.

Sharing Locations

Share your Favorites with other zūmo
owners. You must have an SD card
inserted with available storage space.
1. Touch Where to >
Favorites.
2. Select the location you want to share.
3. Touch Share.
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WHERE TO
4. Verify that the correct location is
selected, and then touch Export.
5. Touch OK.
6. Eject your SD card, and insert it into
another zūmo.
7. A message appears. Touch Yes to
import the shared locations.
8. Touch Favorites, and then touch the
location you want to import.

9. Touch Import, and then touch OK.
10.Touch Done to go back to the Menu
page.

Finding Saved Locations

Touch Where to >
Favorites.
The locations are listed by distance from
your current location. Touch Spell to
narrow your search.
zūmo 500/550 Owner’s Manual

Saving Your Current Location

From the Map page, touch the vehicle
icon. Touch Yes to save your current
location as a Favorite.

Editing Saved Locations

1. Touch Where to >
Favorites.
2. Touch the location you want to edit.
3. Touch Edit.

4. To edit the location:
Touch Change Name. Enter a name,
and touch Done.
Touch Change Map Symbol. Touch
a symbol.
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Touch Change Phone Number. Enter
a phone number, and touch Done.
Touch Delete to remove this item.
A list of all your Favorites appears.
Touch the item you want to delete.
Touch Delete > Yes.

Creating a Saved Route

Use your zūmo to create and save routes
before your next trip. You can save up to
50 routes.
1. Touch Where to >
Routes >
New.
2. Touch Add New Start Point.
3. Find a location as your starting point,
and touch Select.
4. Touch Add New End Point.
5. Find a location as your ending point,
and touch Select.
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6. Touch
to add another location to
your route. TIP: Use the Near button
to narrow your search, see page 19.
to remove a location.
Touch
7. Touch Map to calculate your route,
and view it on the map.
8. Touch Back to exit and save the
route.

Editing Saved Routes

1. Touch Where to >
Routes.
2. Select the route you want to edit.
3. Touch Edit.
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4. To edit the route:
Touch Change Name. Enter a new
name, and touch Done.
Touch Add/Remove Points to add
new start, stop, or end points to the
route.
Touch Manual Reorder to change
the order of points along your route.
Touch Optimal Reorder to
automatically order the points
according to straight line distance
between your start and end points.
Touch Recalculate to change the
route preference to calculate by faster
time, shorter distance, or off road.
Touch Delete to remove this item. A
list of all your routes appears. Touch
the item you want to delete. Touch
Delete > Yes.

NOTE: Your changes are
automatically saved when you
exit any of the route edit pages.
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Sharing Routes

Share your saved routes with other zūmo
owners. You must have an SD card
inserted with available storage space.
1. Touch Where to >
Routes.
2. Select the route you want to share.
3. Touch Share.

4. Verify that the correct route is
selected, and then touch Export.
5. Touch OK.
6. Eject your SD card, and insert it into
another zūmo.
7. A message appears. Touch Yes to
import the shared route.
8. Touch Routes, and then touch the
route you want to import.
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Tips for Browsing the Map

9. Touch Import, and then touch OK.
10.Touch Done to go back to the Menu
page. To view your imported routes,
touch Where to > Routes.

NOTE: You can also share routes
using Google Earth. Go to
http://earth.google.com.

Finding a Location Using
the Map
Use the Browse Map page to view
different parts of the map. Touch
Where to >
>
Browse Map.
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• Touch the map and drag to view
different parts of the map.
• Touch and to zoom in and out.
• Touch any object on the map. An
arrow appears pointing at the object
you selected.
• Touch Back to return to the previous
screen.
• Touch Save to save this location to
your
Favorites.
• Touch Go to create a turn-by-turn
route to the location.
• If the GPS is off, touch Set Loc. to
set the arrow location as your current
location.
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Entering Coordinates

If you know the geographic coordinates
of your destination, you can use your
zūmo to navigate to any location using
its latitude and longitude coordinates.
Touch Where to >
>
Coordinates.

Touch Format to change the type of
coordinates. Because different maps and
charts use different position formats, the
zūmo allows you to choose the correct
coordinate format for the type of map
you are using.
Touch Next for more options:
• Touch Go to create a turn-by-turn
route to the coordinates.
• Touch Show Map to view this
location on the map.
zūmo 500/550 Owner’s Manual

• Touch Save to save this location to
your
Favorites.

Expanding Your Search

1. Touch Where to > Near.
2. Select an option:
Where I Am Now—searches near
your current location.
A Different City—searches near the
city you specify.
My Current Route—searches along
the route you are currently navigating.
My Destination—searches for
locations near your current route
destination.
3. Touch OK.

NOTE: Your zūmo automatically
searches near your current
location.

19
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USING THE MAIN PAGES
Map Page

On the Menu page, touch
View map to open the Map page. The
shows your current location.
To save your current location, touch
the vehicle icon, and touch Yes.
Touch

vehicle icon

Touch the directions bar to
open the Turn List page.

to zoom out.

Touch

to zoom in.

Touch Menu to return
to the Menu page.
Touch Speed to open
the Trip Information
page.

Touch Turn In to open
the Next Turn page.
Map Page while Navigating a Route

Trip Information Page
20

Turn List Page

Next Turn Page
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Trip Information Page

Using the Fuel Gauge

The Trip Information page shows your
current speed and provides helpful
statistics about your trip. To view the
Trip Information page, touch Speed on
the Map page.

The fuel gauge is for motorcycle use
only. You can track your fuel usage when
the zūmo is in the motorcycle mount.
The fuel gauge is only as accurate as the
data you enter.

Resetting Trip Information

1. On the Map page, touch Speed to
open the Trip Information page.
2. Touch Reset > Miles Per Tank.

If you want accurate trip information,
reset the trip information before
beginning a trip. If you make frequent
stops, leave the zūmo turned on so it can
accurately measure elapsed time during
the trip.
Touch Reset > Trip Data to reset the
odometer and time information.
Touch Reset > Max Speed to reset the
maximum speed.
Touch More to view total time, moving
time, and stopped time.
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3. Enter an amount, and touch Done.
4. A message appears when you have
30 miles (~48.3 km) remaining.
5. On the Map page, touch the
icon
to search for a nearby fuel station.
6. To reset the fuel gauge, go
to the Trip Information page,
and touch the fuel gauge >
Yes.
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Turn List Page

When you are navigating a route, the
Turn List page shows turn-by-turn
instructions for your entire route and
the distance between turns. Touch the
directions bar on the top of the Map page
to open the Turn List page. Touch a turn
on the list to view the Next Turn page for
that turn. Touch Show Map to view the
entire route on the map.
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Next Turn Page

When you are navigating a route, the
Next Turn page shows the turn on the
map and the distance and time left before
you reach the turn. To view an upcoming
turn on the map, touch Turn In on the
Map page, or touch any turn from the
Turn List page.
Touch
and
to view other
turns in the route. When you are ﬁnished
viewing the Next Turn page, touch Back.
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USING HANDS-FREE
FEATURES
Using Bluetooth® wireless technology,
your zūmo can connect to your mobile
phone and wireless headset to become a
hands-free device. To see if your device
with Bluetooth technology is compatible
with the zūmo, visit www.garmin.com/
bluetooth.
Bluetooth wireless technology
establishes a wireless link between
devices, such as a mobile phone,
wireless headset, and the zūmo. The
ﬁrst time you use two devices together
you must “pair” them by establishing a
relationship using a PIN/ passkey. After
the initial pairing, the two devices can
connect automatically each time you turn
them on.
NOTE: You might have to
set your device to connect
automatically when the zūmo is
turned on.
zūmo 500/550 Owner’s Manual

Why should I pair my
phone and headset with
my zūmo?

To get the full features of the zūmo,
you should pair your phone to the
zūmo and also pair your headset to
the zūmo. In addition to hands-free
phone use, you can also hear zūmo
navigation prompts through your
headset.
For additional zūmo audio options,
see page 46.

Pairing Your Device

To pair and connect, your device and the
zūmo must be turned on and be within
10 meters of each other.
Initiate pairing from your zūmo or
from your mobile phone. Refer to your
phone’s instructions.
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To pair using the zūmo settings:
1. On the zūmo’s Menu page, touch
>
Bluetooth.

2. Touch the Add button next to the
“Connect Phone” or “Connect
Headset” option.
3. Enable your device’s Bluetooth
component and enable Find Me/
Discoverable/Visible mode. These
settings might be in a Bluetooth,
Connections, or Hands-free menu.
4. Touch OK on the zūmo.
5. Select your device, and touch OK.
6. Enter the zūmo’s Bluetooth PIN
(1234) in your phone, if necessary.
7. On the zūmo, touch and hold Back to
return to the Menu page.
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To pair using the phone settings:

1. Enable the phone’s Bluetooth
component. This might be in a
menu called Settings, Bluetooth,
Connections, or Hands-free.
2. Initiate a search for Bluetooth
devices. This might be located in a
menu called Bluetooth, Connections,
or Hands-free.
3. Select the zūmo from the list of
devices.
4. Enter the zūmo’s Bluetooth PIN
(1234) into your phone.
5. On the zūmo, touch and hold Back to
return to the Menu page.

NOTE: Each time you turn on
the zūmo, it tries to connect to
the last device with which it was
connected.
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Getting a Call

When your phone is connected with
the zūmo, the icon appears in the
upper-left corner. When your headset
is connected with the zūmo, the
icon appears in the upper-left corner.
When you get a call, the Incoming Call
window opens.

Touch Answer to answer the call. Touch
Ignore to ignore the call and stop the
phone from ringing.

In a Call

After you have made or answered a
call, the In Call icon appears on the
screen. Touch for more options:
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Touch End Call to hang up.
Touch Call Options view the following
in call settings:
Touch Tones—displays a keypad page
so you can use automated systems, such
as voice mail.
Transfer Audio To Phone—to switch
audio to your phone. This is helpful if
you plan to turn off the zūmo, but want
to stay on the call. You can also transfer
a call to your phone if you need privacy
or your headset is malfunctioning. To
switch back, touch Transfer Audio To
Device.
Mute Microphone—to mute the
microphone during a call. It mutes a
wired microphone, wireless headset
microphone, or the internal microphone
on the automotive mount.
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Using Call Waiting
NOTE: If your phone does not
support call waiting through
Bluetooth, this feature will not
work.

Phone Menu

On the Menu page, touch
to open
the Phone menu. Not all phones support
all features of the zūmo Phone menu.
Refer to your phone’s instructions.

If you get a call during a call, the
Incoming Call window appears. Touch
Answer to answer the call. The ﬁrst call
is placed on hold.
To switch between calls:
1. Touch

to open the In Call menu.

Press Status to view the connected
phone’s signal strength, battery level,
carrier, and name.

2. Touch Switch To.
3. Touch End Call to hang up; this does
not disconnect the call on hold.
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Using Your Phone Book
NOTE: The phone book feature
is only available if your phone
supports phone book transfer.
Each time your mobile phone connects
with the zūmo, the phone book is
automatically loaded into the zūmo. It
may take a few minutes for the phone
book to be available.
1. Touch

>

Phone Book.

Dialing a Point of Interest

1. Touch
>
Food, Hotels.
2. Search for the point of interest you
want to call.

3. Touch Dial or

Dialing a Number
1. Touch

2. Touch the phone book entry you want
to call.
3. Touch Dial.

zūmo 500/550 Owner’s Manual

.

>

Dial.

2. Enter the number, and touch Dial.
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Viewing Your Call History
NOTE: Call history is only
available if your phone supports
call history transfer.
Each time your phone connects to the
zūmo, your call history is automatically
transferred to the zūmo. It may take a
few minutes to transfer this data to the
zūmo.
1. Touch
>
Call History.
2. Touch Missed, Dialed, or Received
to view those calls. The calls are
listed in chronological order; the most
recent calls are at the top of the list.
3. Touch an entry, and touch Dial.

Calling Home

Enter a phone number for your home
location, so you can quickly call home.
Enter a Home Phone Number
1. Touch

>

Call Home.

2. Touch Enter Phone Number to use
the keypad page or Select From
Phonebook (only available if your
phone supports phone book transfer).
3. Touch Done > Yes. The zūmo dials
your home phone number.

NOTE: To edit home location or
phone number, touch Where
to >
Favorites > Home >
Edit.
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Call Your Home

Touch
>
Call Home. The
zūmo dials your home phone number.

Placing Calls Using Voice Dial
NOTE: Voice dial is only
available if your phone supports
voice dialing.
You can place calls by speaking the
contact’s name into the microphone.
1. Touch
>
Voice Dial.
2. Speak the contact name.

NOTE: You may need to “train”
your mobile phone to recognize
your voice commands. Refer to
your phone’s instructions.

zūmo 500/550 Owner’s Manual
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TRAFFIC INFORMATION
Your zūmo can receive and use trafﬁc
information using an optional FM
TMC (Trafﬁc Message Channel) trafﬁc
receiver (such as the GTM™ 20) or an
XM smart antenna (such as the GXM™
30). When a trafﬁc message is received,
your zūmo displays the incident on the
map and can change your route to avoid
the trafﬁc incident.
NOTE: Garmin is not
responsible for the accuracy
of the trafﬁc information. The
trafﬁc receiver or antenna simply
receives signals from the trafﬁc
service provider and displays that
information on your zūmo.

Trafﬁc icon for North America
Trafﬁc icon for Europe
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Viewing Trafﬁc Incidents
NOTE: You can only access the
trafﬁc information if the zūmo is
connected to a trafﬁc receiver or
antenna (see page 51).
1. On the Menu page, touch
show a list of trafﬁc incidents.
2. Select an item to view details.
3. Select an option.

to

Avoiding Trafﬁc

The Map page displays
or
when
there is a trafﬁc incident on your current
route or on the road on which you are
traveling.

1. From the Map page, touch
.

or
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2. Select an item to view details.
3. Touch Avoid.

Purchasing Trafﬁc
Subscriptions

You can renew and purchase new
subscriptions at www.garmin.com/
trafﬁc.

Adding a Subscription

1. Touch
>
>
Services.
2. Touch FM Trafﬁc or XM
Subscriptions.
3. Touch Add or Subscribe.
4. Follow the on-screen instructions.

NOTE: Additional
documentation is included with
your Garmin trafﬁc receiver or
antenna.

FM Trafﬁc

For more information about an FM
trafﬁc receiver, go to www.garmin
.com/trafﬁc. For participating FM trafﬁc
subscription providers and coverage
cities, go to www.garmin.com/fmtrafﬁc.
NOTE: The FM trafﬁc receiver
and zūmo must be in data range
of an FM station transmitting
TMC data to receive trafﬁc
information.

XM Trafﬁc

For more information about an XM
smart antenna, go to www.garmin
.com/trafﬁc. For subscription
information and coverage cities for XM
NavTrafﬁc, go to www.xmnavtrafﬁc.
com.
NOTE: XM subscriptions are
available for North America only.
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USING XM RADIO
Your zūmo can receive XM radio using an optional XM smart antenna (such as
the GXM™ 30). To purchase an XM smart antenna, go to www.garmin.com. For
subscription information, go to www.xmradio.com or call 800-967-2346.

Listening to XM Radio
NOTE: You must purchase and activate your XM service before you can use
the XM features.
1. Connect the antenna to the zūmo mount (see pages 3 and 51). External power is
required.
2. On the Menu page, touch
to open the Media Player.
3. Touch Source to view the XM tuner. See page 37, to learn about the MP3 player.
Now
playing

XM signal
strength

Browse
category

Touch
to go to the next channel in the browse category.
Touch
to go to the previous channel in the browse category.
Touch Browse to search a category, such as Recent Channels, Kids, or Urban. Next
to each channel is the current program information. Touch a channel to listen to that
channel.
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Touch 123 to enter an XM channel. Then touch Done to listen to that channel.
Touch Save to save a channel to Presets (maximum of 20).
Touch
to remove the current channel from your Presets. To delete more than
one channel from Presets, touch Browse > Presets > Delete. A list of all your Presets
appears. Touch the items you want to delete. Touch Delete > Yes.

Viewing the
Presets

Removing
Channels From
Presets

Adjusting the Volume

Press
, and then use
and
to adjust the volume.
For advanced volume settings, touch
> Volume. For
zūmo audio options, see page 46.
NOTE: Additional documentation is included with
your Garmin XM smart antenna.
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MANAGING FILES ON
YOUR ZŪMO
You can load ﬁles to the internal memory
or an optional SD card.

Step 1: Insert an SD Card
(Optional)

To insert or remove the card, press it in
until it clicks.

NOTE: The zūmo is not
compatible with Windows® 95,
Windows 98, or Windows Me
operating systems. This is a
common limitation of most USB
Mass Storage Devices.

Supported File Types

• MP3 music ﬁles
• JPEG and JPG image ﬁles for splash
screen or picture viewer
• GPI custom POI ﬁles from Garmin’s
POI Loader
• GPX waypoint ﬁles and maps from
MapSource
NOTE: The zūmo does not
support M4A/M4P ﬁles.
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Mini-USB port for AC
adapter, USB Mass
Storage mode, and
updating software

SD card
slot

Step 2: Connect the USB
Cable

1. Plug the small end of the USB cable
into the mini-USB port.
2. Connect the larger end of the USB
cable to an available USB port on
your computer.
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Two additional drives appear in your
computer’s list of drives. “Garmin”
is the available storage in the zūmo’s
internal memory. The other removable
disk drive is the SD card.
NOTE: If the drive is not named
automatically, see your Help ﬁle
or page 58 to rename the drive.

Step 3: Transfer Files to
Your zūmo
For Windows

1. Connect the zūmo to your computer.
2. Double-click
My Computer.
3. Browse your computer for the ﬁle you
want to copy.
4. Highlight the ﬁle, and select Edit >
Copy.
5. Open the Garmin drive or the SD
card drive.
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6. Select Edit > Paste. The ﬁle appears
in the list of ﬁles on the Garmin or SD
card drive.

NOTE: You can also drag and
drop ﬁles to and from your
drives.
For Mac®

1. Connect the zūmo to your
computer. Your Garmin
and SD card drives should
Volume
mount onto your Mac
icon
desktop as two mounted
volumes.
2. To copy ﬁles to your Garmin or SD
card drive, drag and drop any ﬁle or
folder onto the volume icon.
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Step 4: Eject and Unplug
For Windows
When you are ﬁnished transferring ﬁles,
double-click the
Unplug or Eject
icon in your Windows system tray.
Select USB Mass Storage Device, and
click Stop. Select the drive, and click
OK. You can unplug the USB cable from
your zūmo now.
For Mac
When you are ﬁnished transferring
ﬁles, drag the volume icon to the Trash
(it turns into an Eject icon) to
unmount the device. You can unplug the
USB cable from your zūmo now.
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Deleting zūmo Files

You can delete ﬁles from your zūmo
just as you would delete ﬁles from your
computer.
Connect the zūmo to your computer,
and open your Garmin or SD card
drive. Select the ﬁle that you want to
delete, and press the Delete key on your
computer’s keyboard.
CAUTION: If you are not sure
about a ﬁle’s purpose, do not
delete it. Your zūmo memory
contains important system ﬁles
that should not be deleted. Be
cautious of ﬁles located in folders
entitled “Garmin.”
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LISTENING TO MP3
FILES
Load MP3 ﬁles to the internal memory
or an optional SD card. See pages 34–36
for more information.
1. On the Menu page, touch
to
open the Media Player.
2. Touch Source to view the MP3
player.
3. Touch Browse.
4. Touch a category.
5. To play the entire category from the
beginning of the list, touch Play All.
To play all starting with a speciﬁc
song, touch the title.
Album art
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Touch the album art to view details
about the MP3 ﬁle.
Tap
to go to the beginning of the
song; touch and hold to skip back.
Tap
to skip to the next song; touch
and hold to skip ahead.
Touch
to stop the song.
Touch
to pause the song.
Touch
to repeat. Touch
to
shufﬂe.
NOTE: The zūmo plays MP3
ﬁles only; it does not support
M4A/M4P ﬁles.
Press
, and then use
and
to
adjust the volume. For advanced volume
settings, touch
> Volume. For
zūmo audio options, see page 46.
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CUSTOMIZING THE ZŪMO
1. From the Menu page, touch
.
2. Touch the setting you want to change.
Each setting contains a submenu or a
list.

Changing the Map Settings
Touch

>

Map.

Map Detail—adjust the amount of detail
shown on the map. Showing more detail
may cause the map to redraw slower.
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Map View—change the perspective of
the map.
• Track Up—display the map in 2
dimensions (2D) with your direction
of travel at the top.
• North Up—display the map in 2D
with North at the top.
• 3D—display the map in 3 dimensions
(3D) in Track Up.
Vehicle—touch Change to change
the icon used to show your position
on the map. Touch the icon you want
to use, and then touch OK. Download
additional vehicle icons at www.garmin
.com/vehicles.
Map Info—view the maps loaded on
your zūmo and their version. Touch a
map to enable (check mark) or disable
(no check mark) that map.
Restore—restore the default map
settings.
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Changing the System
Settings
Touch

>

System.

GPS Mode—enable and disable GPS
and WAAS/EGNOS. Turning on the
WAAS/EGNOS setting might improve
GPS accuracy, but it consumes more
battery power. Go to www.garmin.com/
aboutGPS/waas.html for information
about WAAS/EGNOS.

Garmin Lock—turn on Garmin Lock
to lock your zūmo. Enter a 4-digit PIN,
and set a security location. For more
information, see page 10.
About—display your zūmo’s software
version number, unit ID number, and
audio version number. You need this
information when you update the system
software (see page 49) or purchase
additional map data (see page 50).
Restore—restore the default system
settings.

Safe Mode—turn Safe Mode on or off.
When your vehicle is moving, Safe
Mode disables all functions that require
signiﬁcant operator attention and could
become a distraction while driving.
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Localizing Your zūmo
Touch

>

Locale.

To change a setting, touch the button
next to the icon.
To change all settings, touch Change
All. In each screen, select the setting,
and then touch OK.
Locale—select your location.
Text Language—set all on-screen
text to the selected language. Changing
the text language does not change the
language of user-entered data or map
data, such as street names.

40

Voice Language—set the language
for voice prompts. Languages noted
with a person’s name are text-tospeech (TTS) voices, which have an
extensive vocabulary and pronounce
the street names as you approach
turns. The prerecorded voices (those
without a person’s name) have a limited
vocabulary and do not speak names of
locations or streets.
Time Format—choose a 12-hour,
24-hour, or UTC time format.
Time Zone—select a time zone or
nearby city from the list.
Daylight Saving—set to On, Off , or
Auto, if it is available.
Units—set units of measure to
Kilometers or Miles.
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Managing User Data
Touch

>

User Data.

Set Home Location—enter or change
your home location. See page 12.
Import Data—load Favorites, routes,
trip logs, and pictures from your Garmin
drive or SD card.
Manage Trip Log—view the current
trip log usage. The zūmo stores your
last 10,000 points of trip data. At the
start of your next big trip, you may want
to reset the trip log. Touch Clear Trip
Log. Clearing a large trip log may take
a few minutes. You can also reuse recent
trip information. Touch Save As Route
to select and save a recent trip segment
as a route. For more information about
routes, see page 16.
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View Pictures—view pictures saved to
your Garmin drive or SD card. Touch
a thumbnail to view the image. Touch
the image again to zoom using and
. Touch the picture and drag to view
different parts of the picture.
To share pictures with another
zūmo user:
1. Touch a thumbnail.
2. Touch Share.

3. Verify that the correct picture is
selected, and then touch Export.
4. Eject your SD card, and insert it into
another zūmo.
5. A message appears. Touch Yes to
import the shared picture.
6. Touch Pictures > touch a thumbnail
> Import.
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7. Verify that the correct picture is
selected, and then touch Import.

Touch Slide Show to display each image
for a few seconds and then display the
next image. During the slide show, touch
the screen at any time to stop and see
more options.

Bluetooth Technology
Settings
Touch

>

Bluetooth.

Connect Phone—select Add Device
> OK to pair with a mobile phone that
has Bluetooth® wireless technology. See
pages 23–29.
NOTE: The zūmo’s PIN code (or
passkey) is 1234.

disconnect, and touch Yes.
• Remove—select the phone you want
to delete from the zūmo’s memory,
and touch Yes.
Phone Help—scroll through the list
containing compatible devices. If
your phone is not in this list, go to
www.garmin.com/bluetooth for more
information.
Connect Headset—connect to a headset
that has already been paired, or select
Add Device.
Bluetooth—enable and disable the
Bluetooth component. The Bluetooth
icon appears on the Menu page if the
Bluetooth component is enabled. To
prevent a phone from automatically
connecting, select Disabled.
Friendly Name—touch Edit to enter a
friendly name that identiﬁes your zūmo
on devices with Bluetooth technology.
Touch Done.

• Drop—select the phone you want to
42
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Restore—restore the default Bluetooth
settings. Restoring the Bluetooth settings
does not clear the pairing information.

Changing the Navigation
Settings
Touch

>

• Off Road—to calculate point-topoint routes (without roads). On the
Map page, touch or press
to
scroll to the Compass page.

Navigation.

Route Preference—select a preference
for calculating your route:
• Faster Time—to calculate routes that
are faster to drive but can be longer in
distance.
• Shorter Distance—to calculate
routes that are shorter in distance but
can take more time to drive.
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Vehicle Type—specify your vehicle type
to optimize routes.
Avoidances—select the road types you
want to avoid on your routes. The zūmo
uses these road types only if alternative
routes take you too far out of your way
or if no other roads are available. If you
have a trafﬁc receiver or antenna, you
can also avoid trafﬁc incidents.
Attention Tone—turn on or off the
attention tone.
Restore—restore the default navigation
settings.
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Customizing the Display
Touch

>

Display.

Color Mode—select Daytime for a
light background, Nighttime for a dark
background, or Auto to automatically
switch between the two.
Splash Screen—select an image to be
shown when you turn on the zūmo. First,
load JPEG images. See pages 34–36.
Brightness— raise and lower the
backlight brightness using and .
Screen Shot—enable Screen Shot mode.
Touch the
camera icon to take a
picture of the screen. The picture bitmap
ﬁle is saved in the Garmin\scrn folder
on the Garmin drive.
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Changing the Keyboard

Touch
>
Keyboard.
Standard—displays a full alphabetic
keyboard.

Large Buttons—displays a large button
touch-screen keyboard. This option is
suited for motorcyclists wearing gloves.
See page 13.
Auto—select to automatically switch
between the standard keyboard when
using the zūmo in the automotive mount
and the large button keyboard when
using the zūmo in the motorcycle mount.
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Restoring All Settings

1. From the Menu page, touch
.
2. Touch Restore, and then touch
Yes. This restores all of your zūmo
settings to the factory defaults.

Clearing All User Data
CAUTION: This deletes all
user-entered information
including Favorites, routes, trip
logs, settings, and recent ﬁnds.
1. Hold your ﬁnger on the lower-right
corner of the zūmo’s screen while
turning on the zūmo.
2. Keep your ﬁnger pressed until the
pop-up window appears.
3. Touch Yes to clear all user data.
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APPENDIX
zūmo Audio Options

Battery power

Phone

Automotive
mount with
external power
(included with
zūmo 550)

XM Radio

Motorcycle
mount with
external power

MP3

Power
Source

Navigation
Prompts

NOTE: Audio from MP3s and XM radio is stopped during phone calls and
navigation prompts. Navigation prompts are muted during phone calls.

Wired headset
or helmet with
microphone

●

●

●

●

Bluetooth headset

●

●

○

●

Internal speaker
and microphone

●

●

●

●

Wired headset or
headphones with
wired microphone

●

●

●

●

Bluetooth headset
and
internal speaker

○

○

○

●

Adjust volume on headset.

●

●

●

-

Adjust volume on zūmo.

Bluetooth headset

●

●

○

●

Fully charged battery lasts
up to 4 hours.

Audio Option

Notes

● Audio available, ○ No audio available, - Not applicable
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Installing the zūmo in Your Automobile

Your zūmo 550 includes an additional mount for your automobile so you can easily
transfer the unit. Select a suitable location in your vehicle for safe cable routing and
safe operation. Clean and dry the selected area of your windshield.

Lever

Mounting on Your
Windshield

1. Place the suction cup on the
windshield. Flip the suction
lever back, toward the
windshield.
2. Plug the power cable into the
side of the mount.
3. Place the zūmo into the
automotive mount, and ﬂip the
lever down.
4. Plug the power cable into a
power receptacle in your
vehicle. Your zūmo should
turn on automatically if the
vehicle is running.

ield

sh

nd
Wi

Suction
cup

Suction
lever

Power cable

Automotive
mount

Lever
Suction cup arm,
lever back

Mini-USB port
3.5 mm audio out jack
2.5 mm microphone jack
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Mounting on Your Dashboard
Use the enclosed mounting disk to
mount your zūmo on the dashboard and
to comply with state regulations.
NOTE: The permanent
mounting adhesive is extremely
difﬁcult to remove after it is
installed.
1. Clean and dry the dashboard where
you want to place the disk.
2. Remove the backing from the
permanent mounting adhesive on the
bottom of the disk.
3. Place the disk on the dashboard.
4. Place the suction cup part of the
automotive mount on top of the disk.
5. Flip the suction lever down (toward
the disk).
6. Follow steps 2–4 on page 47.
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Removing the zūmo from the
Mount

To remove the zūmo from the mount,
ﬂip up the lever on the mount. Lift out
the zūmo.
You can separate the suction cup from
the automotive mount. Turn the mount as
far as you can to the right or left. Apply
pressure in that direction until the mount
snaps off the arm.
NOTE: Reconnecting the
suction cup to the automotive
mount requires signiﬁcant force.
Press the ball end ﬁrmly into the
socket.
To remove the suction cup from the
windshield or mounting disk, ﬂip the
suction lever up. Pull the tab on the
suction cup toward you.
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Charging the zūmo

1. Connect the power cable to a mount
and a power source.
2. Place the zūmo in the mount, and ﬂip
the lever down.
OR
1. Charge the zūmo with the AC
adapter. Plug the small end of the AC
adapter into the mini-USB port on the
bottom of the zūmo.
2. Plug the other end into a standard
wall outlet.

Updating the zūmo
Software

1. Go to www.garmin.com/products/
webupdater to download the
WebUpdater program to your
computer.
2. Connect the zūmo to your computer
using the mini-USB cable.

Resetting the zūmo

If your unit freezes up, press and hold
and press
.

Calibrating the Screen

If the touch screen is not responding
properly, calibrate the touch screen.
Turn the unit off. Press and hold
for
about one minute until the Calibration
screen appears. Follow the on-screen
instructions.
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Mini-USB port for AC adapter, USB Mass
Storage mode, and updating software

3. Run WebUpdater, and follow the
screen prompts. After conﬁrming
that you want to perform an update,
WebUpdater automatically downloads
the update and installs it on your
zūmo.
4. Eject and unplug your zūmo (see
page 36).
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Register your zūmo to receive
notiﬁcation of software and map
updates. To register your zūmo, go to
http://my.garmin.com.
You can also download software updates
from www.garmin.com/products/zumo.
Click Updates and Downloads, and
follow the instructions.

You can also purchase additional map
data from Garmin and load the maps to
the internal memory or an optional SD
card.
Refer to the MapSource Help ﬁle
for more information about using
MapSource and loading maps and
waypoints on your zūmo.

Purchasing and Loading
Additional Map Data

Optional Accessories

To ﬁnd out the version of the maps that
are loaded on your zūmo, touch
>
Map > Map Info. To unlock
additional maps, you need your unit ID
and serial number.
Check www.garmin.com/unlock/update
.jsp to see if an update for your map
software is available.
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For more information about optional
accessories, go to www.garmin.com/
products/zumo and click the Accessories
link. You can also contact your Garmin
dealer to purchase accessories. Optional
accessories include:
• Trafﬁc receiver or antenna
• External remote antenna
• External microphone
• Extras (see pages 51–53)
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Connecting Accessories to
Your zūmo

Some Garmin trafﬁc receivers and
XM antennas must be plugged into a
mini-USB port on the zūmo mount.
The microphone and audio out jacks
are located on the left side of the zūmo
mount.
Microphone
and audio
out jacks
Mini-USB
port

zūmo Motorcycle Mount Shown

To see the automotive mount
connections, see page 47.
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Garmin Travel Guide™

Much like a paper travel guide, the
Garmin Travel Guide provides detailed
information about locations, such as
restaurants and hotels. To purchase the
Travel Guide accessory, go to
www.garmin.com/extras.
To use the Travel Guide:

1.
2.
3.
4.

Insert the SD card into your zūmo.
Touch Where to >
Extras.
Touch the Travel Guide.
Touch a category. Touch a subcategory, if necessary.
5. Touch a location in the list.
6. Do one of the following:
Touch Go to go to the location.
Touch Map to view this item on the
map.
Touch Save to save this location to
your
Favorites.
Touch More to view more information
about the location.
51

APPENDIX

Safety Cameras

Safety camera information is available in
some locations. (Check www.garmin
.com/accessories/safetycamera for
availability.) For these locations, your
zūmo includes the locations of hundreds
of safety cameras. Your zūmo alerts
you when you are approaching a safety
camera and can warn you if you are
driving too fast. The data is updated at
least weekly, so you always have access
to the most up-to-date information.
To get updated safety camera
information:

1. Go to http://my.garmin.com.
2. Sign up for a subscription.

You can purchase a new region at
any time, and you can extend existing
subscriptions at any time. Each region
that you purchase has its own expiration
date.
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Custom POIs (Points of
Interest)

Load custom points of interest (POIs)
onto your zūmo. POI databases are
available from various companies on the
Internet. Some custom databases contain
alert information for points, such as
school zones. A warning appears if you
are traveling too fast near these custom
POIs.
Use the Garmin POI Loader to load
POIs on your Garmin drive or SD card.
Download the POI Loader from
www.garmin.com/extras.
Refer to the POI Loader Help ﬁle for
more information; press F1 to open the
Help ﬁle.
To view your custom POIs, touch
Where to >
Extras >
Custom POIs.
To turn on or off custom POIs, touch
>
Proximity Points >
Proximity Alerts.
zūmo 500/550 Owner’s Manual

APPENDIX

To delete the custom POIs from your
zūmo, connect your zūmo to your
computer. Open the Garmin\poi folder
in the Garmin or SD card drive. Delete
the ﬁle entitled poi.gpi.
CAUTION: Garmin is not
responsible for the consequences
of using a custom POI database
or the accuracy of the safety
camera or other custom POI
database.

Garmin TourGuide™

The Garmin TourGuide allows your
zūmo to play third-party, GPS-guided
audio tours. These audio tours can take
you on a route while playing interesting
facts about historical sites along the way.
As you travel, the audio information
is triggered by GPS signals. For more
information, go to www.garmin.com/
extras and click POI Loader.
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To view your Garmin TourGuide ﬁles,
touch Where to >
Extras >
Custom POIs.
To change the Garmin TourGuide
settings, touch
>
Proximity
Points > TourGuide. Select Auto
Play to hear the complete tour as
programmed, Prompted to show the
speaker icon
on the map when tour
information is available during your
route, or Off.

SaversGuide®

The SaversGuide is an optional
accessory that is available only in North
America (www.garmin.com/extras).
With the SaversGuide preprogrammed
SD data card and membership card,
your zūmo is a digital coupon book that
notiﬁes you of merchants near your
current location where you are eligible
for a discount, such as restaurants,
hotels, and movie theaters.
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Battery Information

Your zūmo contains an internal lithiumion battery. The battery lasts up to 4
hours, depending on usage.
The
battery icon on the Menu
page indicates the status of the internal
battery. If the icon is not present, your
zūmo is connected to external power. For
information about charging your zūmo,
see page 49.

Maximizing the Battery Life

• Turn off GPS (
>
System
> GPS Mode > GPS Off) when you
do not need to receive GPS signals,
or use Normal mode when WAAS or
EGNOS is not available.
• Turn the backlight brightness down.
Press and hold
, and then use
and
to adjust the brightness.
• Do not leave your zūmo in direct
sunlight. Avoid prolonged exposure
to excessive heat or cold.
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Replacing the Battery

To purchase a replacement lithium-ion
battery pack, go to www.garmin
.com/products/zumo, and click the
Accessories link.
Unscrew the battery pack and replace
the battery. Contact your local waste
disposal department for information on
properly disposing of the battery.
Screw
Battery
pack
MCX
connector
under
weather cap
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Using a Remote Antenna

Cleaning the Unit

Caring for Your zūmo

Cleaning the Touch Screen

You can use an optional external remote
antenna (Garmin GA 25MCX). To
purchase, go to www.garmin.com/
products/zumo, and click the
Accessories link.
Pull back the weather cap from the MCX
connector located on the back of the
zūmo, and connect the antenna.
Your zūmo contains sensitive electronic
components that can be permanently
damaged if exposed to excessive shock
or vibration outside normal motorcycle
or automobile use. To minimize the
risk of damage to your zūmo, avoid
dropping your unit and operating it in
extreme high-shock and high-vibration
environments.
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The zūmo is constructed of highquality materials and does not require
user maintenance other than cleaning.
Clean the unit’s outer casing (not the
touch screen) using a cloth dampened
with a mild detergent solution, and
then wipe dry. Avoid chemical cleaners
and solvents that can damage plastic
components.
Clean the touch screen with a soft, clean,
lint-free cloth. Use water, isopropyl
alcohol, or eyeglass cleaner, if needed.
Apply the liquid to the cloth, and then
gently wipe the touch screen.

Protecting Your zūmo

• Carry and store your zūmo in the
included carrying case.
• Do not store your zūmo where
prolonged exposure to extreme
temperatures can occur (such as in
the trunk of a car), because it can
cause permanent damage.
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• Though a PDA stylus can also be
used to operate the touch screen,
never attempt this while operating
a vehicle. Never use a hard or sharp
object to operate the touch screen or
damage may result.

Avoiding Theft

• To avoid theft, remove the zūmo and
mount from sight when not in use.
• Use the Garmin Lock™ feature. See
page 10.

Changing the Fuse

An AGC/3AG 2-Amp, high-breaking
capacity, 1500 A-rated fuse is located
at the tip of the vehicle adapter.
Periodically, you may need to change
the fuse. Unscrew the black, round end
piece, and replace the fuse.

About GPS Satellite Signals
Your zūmo must acquire GPS (Global
Positioning System) satellite signals
to operate. If you are indoors, near tall
buildings or trees, or in a parking garage,
your zūmo cannot acquire satellites.
Go outside to an area free from tall
obstructions to use your zūmo.
When your zūmo has acquired satellite
signals, the signal strength bars on the
Menu page are green
. When it
loses satellite signals, the bars turn red or
disappear
.
For more information about GPS, go to
www.garmin.com/aboutGPS.

Unscrew
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Speciﬁcations

Physical size: 4.4” W x 3.2” H x
2.87” D (11.3 x 8.2 x 7.2 cm)
Weight: 0.59 pounds (269 g)
Display: 2.8” W x 2.1” H (7.2 x 5.4 cm);
320 x 240 pixels; bright, 16-bit LCD,
with white backlight and touch screen
Case: IPX7 waterproof
Temperature range: 32°F to 140°F
(0°C to 60°C)
Data storage: Internal memory and
optional removable SD card. Data stored
indeﬁnitely.
Computer interface: USB mass storage,
plug-and-play
Charge time: Approximately 6 hours
Power input: 12/24 VDC
Usage: 15 W max. @ 13.8 VDC
Battery life: up to 4 hours depending on
usage

zūmo 500/550 Owner’s Manual

GPS Performance
Speciﬁcations

Receiver: WAAS enabled
Acquisition times*:
Warm: < 1 sec
Cold: < 38 sec
Factory Reset: < 45 sec
*On average for a stationary receiver
with a clear view of the sky
Update rate: 1/sec, continuous
GPS accuracy:
Position: < 10 meters, typical
Velocity: 0.05 meter/sec RMS
GPS (WAAS) accuracy:
Position: < 5 meters, typical
Velocity: 0.05 meter/sec RMS
For a complete list of speciﬁcations, go
to www.garmin.com/products/zumo/
spec.html.

57

APPENDIX

USB Interface Troubleshooting
Problem/Question

Solution/Answer

How do I know my
zūmo is in USB Mass
Storage Mode?

When your zūmo is in USB Mass Storage Mode, a picture of a
zūmo connected to a computer is shown. Also, you should see
a new removable disk drive listed in My Computer (Windows) or
a new volume (drive) on your desktop (Mac).

My computer never
senses that the zūmo is
connected.

1. Unplug the USB cable from your computer.
2. Turn the zūmo off.
3. Plug the USB cable into your computer and your zūmo.
The zūmo automatically turns on and goes into USB Mass
Storage Mode.

I cannot ﬁnd any drives
named “Garmin” in my
list of drives.

If you have several network drives mapped on your computer,
Windows may have trouble assigning drive letters to your
Garmin or SD drives. Follow the steps on the next page to
assign (map) your drive letters.

I get a message saying
“Unsafe Removal of
Device” when I unplug
the USB cable.

Windows: Double-click the Unplug or Eject
icon in your
system tray. Select USB Mass Storage Device and click Stop.
Select the Garmin drive and click OK. You can unplug your
zūmo now.
Mac: Drag the volume icon to the Trash. The Trash icon
changes to an Eject icon. You can unplug your zūmo now.
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Problem/Question
How can I rename
my Garmin drives in
Windows?

How do I assign (map)
my Garmin drives in
Windows?

Solution/Answer
1.
2.
3.
4.

Open My Computer.
Select the drive you want to rename.
Right-click your mouse, and select Rename.
Type the new name, and press the Enter key on your
computer’s keyboard.

1. Turn off your zūmo.
2. Plug the USB cable into the zūmo and your computer. Your
zūmo automatically turns on.
3. Click Start > Settings > Control Panel > Administrative
Tools > Computer Management > Storage > Disk
Management.
4. Click a zūmo removable disk drive (either the internal
memory or your SD card drive). Right-click your mouse, and
select Change Drive Letter and Path.
5. Select Edit, select a drive letter from the drop-down list, and
click OK.
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zūmo Troubleshooting
Problem/Question

Solution/Answer

The suction cup will not
stay on my windshield.

Clean the suction cup and windshield with rubbing alcohol. Dry
with a clean, dry cloth. Mount the suction cup as described on
page 47.

My battery gauge does
not seem accurate.

Allow the unit to fully discharge and then fully charge it (without
interrupting the charge cycle).

The touch screen is not
responding to my taps
properly.

Calibrate the touch screen. Turn the unit off. Press and hold
for about one minute until the Calibration screen appears.
Follow the on-screen instructions.

My phone/headset
will not connect to the
zūmo.
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Verify that the Bluetooth ﬁeld is set to Enabled.
Make sure your phone is turned on and is less than 10 meters
(about 33 feet) away from your zūmo.
Go to www.garmin.com/bluetooth for a list of compatible phones
and headsets.
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moving 18
update maps 49
using the Map page 20
version 38
view 18, 38
zoom 18
MapSource i, 34, 50
menu page 7
miles 40
mini-USB. See USB
motorcycle installation 3
mounting the zūmo
in a car 47, 48
on a motorcycle 3
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loading 34
playing 37
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myGarmin i, 50, 52

N
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Near button 19
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pairing a headset 24
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Screen Shot mode 44
SD card 1, 34, 57
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settings 38–45
setting your location 12, 18
show map 12, 22
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software
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version 39
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storing your zūmo 55
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transferring ﬁles 34–36
Trip Information page 21
trip log 41
troubleshooting 58–60
turn-by-turn directions 22
Turn List page 22

Z

zoom 18, 20, 41

U
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zūmo software 49
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troubleshooting 58
user data 41

V
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vehicle type 43
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W

WAAS 39
WebUpdater 49

X
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For the latest free software updates (excluding map data)
throughout the life of your Garmin products, visit the Garmin
Web site at www.garmin.com.
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